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1.0 General recommendations

• Before installing the gas system, disconnect the battery earth cable (unless specified to the
contrary by the car maker).
Attention: this may delete the car radio and telephone memories and jam the centralised
door locking and anti-theft systems. In this case, you may connect the battery temporarily.

• Always smooth holes after drilling and apply anti-rust to the edges.
• Apply silicon to each cable through-hole to prevent water from entering the interior.
• Always soft solder connections without connectors to prevent the formation of false con-

tacts.
• Always observe the current laws and/or regulations in the State where the LPG system is

mounted.
• Remember that, as per the relative standards, all the assembly instructions refer to the

driving position.
• Before assembling the “FAST” control unit, make sure the relative fuses are disconnected.
• Do not wash the engine after installation.

ATTENTION
FAILURE TO OBSERVE THE INSTRUCTIONS CONTAINED IN THIS MANUAL MAY CAUSE
THE FAST SYSTEM TO WORK INCORRECTLY OR NOT WORK AT ALL. THIS MAY CAUSE
DAMAGE TO LOVATO COMPONENTS AND INVALIDATE THE WARRANTY.
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2.0 “FAST” gas injection system features
2.1 System description
The system comprises:
- Tank
- Multivalve
- Safety lock-off valve
- Reducer / vaporiser
- Injector assembly
- Electronic control unit
- Compressed air connections
- Gas temperature and pressure sensor
- Wiring harnesses
- Smart injector-cutter control unit
- Switch
- Buzzer.
2.2 Operating principle
The liquid LPG is stored in equilibrium with the vapour phase in a tank fitted with a multivalve.
Storage pressure depends on the composition and temperature of the fuel. The LPG is collected
in its liquid phase and delivered to the reducer/vaporiser along the pressurised piping to which
the LPG lock-off valve is fitted. The reducer/vaporiser is heated by the engine cooling water,
vaporises the fuel and adjusts its pressure, known as injection pressure, to a value that is propor-
tional to the pressure in the inlet manifold downline from the engine butterfly valve (M.A.P.). The
gaseous LPG then reaches the injector assembly controlled by the electronic control unit. The
LPG is batched by the injection time and phasing signal. This is determined by the electronic
control unit according to the signals from the engine and petrol supply system.

2.3 Precautions for fitters
- The vehicle must be fitted with a four (4) cylinder engine with a capacity ranging between

900 and 2,250 cm3 and a maximum power of 85kW.

ATTENTION
MAKE SURE THE ELECTRONIC PETROL INJECTION MANAGEMENT SYSTEM, ESPE-
CIALLY THE LAMBDA PROBE, IS IN PERFECT WORKING ORDER; ANY IRREGULARITIES
OR FAULTS MAY BE TRANSFERRED TO THE GAS INJECTION SYSTEM AND CAUSE IT
TO WORK INCORRECTLY.

• Check the general condition of the car.
• Check the signals required for conversion, especially the Lambda probe.
• Follow the instructions in this manual with care.
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3.0 FAST system components

3.1 FAST kit components

The LPG 4-cylinder FAST Kit comprises the following components:
- 1 12 Volt E67R1 LPG lock-off valve,
- 1 FAST reducer complete with guarantee certificate,
- 1 galvanized reducer support,
- 2 aluminium brackets for control unit and injector assembly,
- 1 FAST injector assembly,
- 1 LPG filter,
- 1 FAST service bag,
- 1 length of 15x23 rubber water hosing,
- 2 lengths of 5x10.5 rubber “only air” hosing,
- 1 length of 12x19 E67R1 rubber hosing,
- 2 lengths of 4x10 E67R1 rubber hosing,
- 1 coil of 4x6 copper piping,
- 1 FAST electronic control unit,
- 1 EMU FAST injector-cutter control unit for emulating the petrol injection signal,
- 1 gas Temperature and Pressure sensor,
- 1 FAST wiring harness,
- 1 EMU FAST emulator wiring harness,
- 1 microswitch,
- 1 acoustic signal,
- 1 use and maintenance manual.

3.2 Description of parts

LPG lock-off valve
This electromagnetic device interrupts the flow of LPG when the en-
gine is stopped or when the fuel supply is switched to the petrol
mode.

Reducer / vaporizer
The reducer / vaporizer provides the heat required to vaporize the
liquid LPG from the tank and reduces and adjusts the pressure of the
LPG in its gaseous phase according to the pressure in the engine
intake system downline from the butterfly valve (MAP, short for Mani-
fold Absolute Pressure). This component is fitted with a temperature
sensor for the petrol / LPG switching procedure, an overpressure
valve and an adjustment screw for modifying the gas reduction pres-
sure.

“FAST” injector assembly
This component delivers the quantity of gaseous LPG determined
for each cycle by the electronic control unit to each cylinder. The
fuel supply is sequenced and phased by the lock-off valves con-
trolled by the electronic control unit.
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LPG filter
This device is installed upline from the injector assembly and pro-
tects it from the impurities in the LPG.

FAST service bag
The service bag contains the nozzles to install on the inlet manifold next to
the combustion chamber, fuse holders with relative fuses, screws, supports
and the hardware required to install the KIT. In particular, the aluminium or
galvanized steel supports can easily be cut and/or bent to size in order to
properly secure the reducer and injector assembly to the car.

Rubber hosing
There are four types of rubber hosing in the Kit:

- water circuit hosing for heating the reducer/vaporizer with the fluid in the
engine cooling circuit.

- “only air” hosing connects the pressure tap downline from the butterfly valve
to the MAP sensor and the reducer/vaporizer. It also connects the overpres-
sure valve of the reducer to the air filter of the engine intake system.

- the various sizes of LPG E67R1 hoses are class 2 approved ac-
cording to European Regulations E67– R01 and connect the re-
ducer to the injector assembly and the lock-off valve outputs to the
corresponding ducts on the inlet manifold.

- coil of copper piping for compressed air connections between the multi-
valve of the tank and the LPG lock-off valve in the engine compartment and
between the lock-off valve and the reducer.

Electronic control unit
This microprocessor-controlled electronic system processes the sig-
nals from the sensors in real time and calculates optimum gaseous
LPG injection times on the basis of the operating conditions of the
engine. It is fitted with a hose connecter for reading the absolute
pressure signal of the inlet manifold (M.A.P.).

EMU FAST injector cutter control unit
This control unit prevents the petrol injection system from working while the
engine is running in the gas mode. The control unit also checks the polarity
of the petrol injector and selects the negative injector sending the signal to
the control unit for processing.
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Gas Temperature / Pressure Sensor
Reads gas pressure and temperature in real time near the injector as-
sembly. The control unit uses this information to calculate gas density
and corrects the opening time of the injectors.

FAST wiring harness
The universal wiring harness supplied with the FAST Kit connects
the electronic LPG sensor to the sensors required to determine the
operating conditions of the engine and the FAST system compo-
nents. In particular, it connects the electronic control unit to the EMU
FAST injector emulator control unit.

EMU FAST emulator wiring harness
This wiring harness connects the EMU FAST control unit to each petrol
injector in order to interrupt petrol operation and transmit the injection
signal for correct engine supply. Dedicated Bosch and Japan wiring har-
nesses are available.

Switch
This electronic device allows the driver to switch the fuel supply from pet-
rol to gas (and vice-versa) and to view the operating status and gas level
in the tank.

Buzzer
This device is directly controlled by the FAST control unit. It sounds
when switching from petrol to LPG, when the LPG level in the tank
reaches reserve and when automatically switching to petrol if the LPG
runs out. For further information on the buzzer please consult chapter
8.0 User information and the use and maintenance manual.
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4.0 Installation sequence
The sequence of operations for installing the system is shown below.
1 Installing the tank, multivalve and high pressure line to the engine compartment (Consult the

specific manual for each product)
2 Locating the installation area for the FAST Injector Assembly
3 Locating the installation area for the FAST Reducer/Vaporiser Assembly
4 Locating the installation area for the LPG lock-off valve
5 Installing the nozzles
6 Installing the FAST Injector Assembly
7 Installing the LPG lock-off valve
8 Installing the FAST Reducer/Vaporiser
9 Installing the FAST control unit
10 Installing the EMU FAST control unit
11 Installing the switch and buzzer
12 Electrical connections
13 Connection between PC and control unit
14 Checking and configuring sensors
15 Calibration
16 Diagnostics
17 Road test

Before starting to mount the components, locate the areas where the FAST devices can be in-
stalled inside the engine compartment according to the following instructions.

4.1 Locating the installation area for the FAST Injector Assembly
Secure the FAST injector assembly to the car using the two steel supports supplied in the kit.
Locate fixing points for the supports bearing in mind that:
- the injector assembly must be positioned as near as possible to the ducts on the engine inlet

manifold in order to minimise the length of the connecting hoses,
- the hoses connecting the outlet nozzles of the assembly to the nozzles mounted on the mani-

fold ducts must all have the same length and have no sharp bends.

ATTENTION
THERE ARE NO CONSTRAINTS TO THE INSTALLATION POSITION OF THE INJECTOR
ASSEMBLY. WE RECOMMEND INSTALLING THE ASSEMBLY WITH THE NOZZLES POINT-
ING DOWNWARDS IN ORDER TO PREVENT POSSIBLE DEPOSITS OF OIL AND DIRT
THAT MAY COMPROMISE LONG-TERM SYSTEM PERFORMANCE.
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4.2 Locating the installation area for the FAST Reducer/Vaporiser
Fix the FAST reducer/vaporiser to the car with the relative steel support, making sure to observe
the following requirements:
- the reducer must be mounted in the position indicated in figure 2.
- the hose connecting the MAP tap on the reducer cover to the pressure tap on the inlet mani-

fold downline from the butterfly valve must be as short as possible. Considering that the MAP
tap must also be connected to the electronic control unit, these components must all be in-
stalled near to each other;

- the high pressure LPG is supplied from underneath
- the gaseous LPG outlet at injection pressure must point towards the FAST injector assemblies

at a fairly close distance
- the reducer must be fed with engine cooling fluid through the relative adjustable pipes
- the overpressure valve must be connected to the engine intake circuit.
- the reducer must be positioned so that it can be easily accessed from above after assembly; it

must also be easy to reach the adjustment screw located on the top of the cover and read its
serial number during its MOT test

- after making all compressed air, hydraulic and electrical connections, the reducer must not
touch or lie dangerously close to moving or hot parts of the car.

Top

Bottomfig. 1
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4.3 Locating the installation area for the LPG Lock-off valve
After deciding on the assembly area for the reducer, locate the position for mounting the on-off
lock-off valve on the high pressure LPG line; place the valve as close as possible to the reducer
but far away from accident impact zones. Mount the lock-off valve vertically with the coil at the top.

4.4 Mounting the nozzles
Mount the nozzles by dismounting the inlet manifold and the air filter box of the car. This will allow
you to make sure the manifold is perfectly clean.

To install the nozzles, proceed as follows:
1. drill a 4.7 mm hole in each of the four ducts of the inlet manifold taking care to centre the hole

in the width of the manifold and as near as possible to the engine intake valve
2. drill a 4.7 mm hole in the stretch of the inlet manifold just downline from the butterfly valve in

the point previously located for the pressure tap on the manifold.

Gas injector nozzles
(6 pieces in service bag)

fig. 3

fig. 2

Pressure adjustment
screw

Union connecting the
reducer to the engine

cooling circuit

Liquid LPG inlet

Bottom

Top

Gaseous LPG outlet

M.A.P. tap

Temperature sensor

Overpressure valve
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3. drill a 4.7 mm hole in the air filter box or, if the car is fitted with a hot wire air flow meter,
immediately downline from it

4. thread each hole with a male M6 tapper
5. fit the six nozzles into the relative holes after applying a drop of thread retainer (Loctite 638)

to each thread

6. clean the inside of the inlet manifold before remounting it.

fig. 5

LPG injection nozzles

M.A.P.
signal

delivery
nozzle

Overpressure discharge nozzle

fig. 4

Ø 4.7 mm M6 holes for installing the LPG
injection nozzles

Ø 4.7 mm M6 hole for installing the M.A.P.
pressure delivery nozzle
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4.5 Mounting the FAST injector assembly

Injector assembly.
Nozzles for injector assembly; these must be sized according to the capacity of the car being
converted.
Injector assembly supports.
Ø 6 washer.
M5 x 25 screws for fixing the supports to the injector assembly.
Nuts for creating a gap between the injector assembly and the support.
Approved E67-R01 4x10 hose for connecting the nozzles of the injector assembly to the
nozzles fixed to the inlet manifold.
Ø10.3 ÷ 12.3 hose clamps for securing the hosing to the nozzles.

Select the nozzles to install on the injector assembly according to the power of the car. There are
two sizes of nozzle:
Ø 2.4 for cars with power outputs equal to or less than 65kW
Ø 2.7 for cars with power outputs from 65 to 85 kW.

To install the Injector Assembly, proceed as follows:
1. Fix the nozzles , chosen according to the kind of car being converted, to the Injector
assembly .
2. Bend and shape the supports  as required.
3. Fix the supports   to the engine.
4. Fix the Injector Assembly  to the supports  with the washers , the two M5 screws 

and the nuts  if required.
5. Make sure that the Injector Assembly  with the wiring harness mounted does not prevent

the bonnet from being closed.
6. Cut one of the lengths of hose  to size in order to connect one of the lateral nozzles on the

manifold to the corresponding outlet on the injector assembly . The hose must be cut so
that the connection is as short as possible and to avoid sharp bends.

fig. 6 4

8

7

6

5

2 1
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7. Cut the other lengths of hose  to the same length
8. Attach the four cut lengths of hose  to the nozzles on the ducts of the inlet manifold and

to the outlets of the injector assembly  using the supplied clamps  and secure them
with the relative tool.

4.6 Installing the LPG lock-off valve

LPG lock-off valve
4.8x16 self-tapping screws for fixing the LPG lock-off valve to the chassis or bodywork of the
car,
Ferrule Ø 6,
M10x1 galvanised connector,
4x6 copper pipe,
Ø 8 car hose clamp,
3.9x9.5 self-tapping screw.

5

1

2

3
4

6
7

fig. 8

fig. 7

E67-R01 hosing for
connecting the

nozzles mounted on
the inlet manifold
to the nozzles on

the injector assem-
bly

LPG hose from
reducer

Injector assembly
Bolt and suitably
shaped bracket

supporting the in-
jector assembly
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Fit the LPG lock-off valve  before installing the reducer; to do this, use the bracket built into the
valve and the two self-tapping screws .

Connect the multivalve mounted on the tank to the LPG lock-off valve  with a suitable length of
copper piping .
Fix the pipe to the multivalve with the double cone  and the galvanised connector  supplied
with the multivalve.
Fix the pipe to the bottom of the car in as protected a position as possible from heat sources and/
or accidental impact as this may cause it to deteriorate or break, using the car hose clamp  and
the self-tapping screws , until it reaches the engine compartment.
Fix the pipe to the gas inlet of the LPG lock-off valve using the double cone  and the galvanised
connector .

Also prepare a section of copper piping that will connect the lock-off valve to the reducer, fixing
it to the lock-off valve and then to the reducer with the double cone and the relative galvanised
connector.

fig. 9

Screw for fixing
the LPG lock-off

valve
to the car bodywork

LPG lock-off valve

Gas inlet connector

Gas outlet union
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4.7 Installing the FAST reducer/vaporiser

Reducer,
Reducer fixing stud bolts,
Reducer fixing spacers,
Reducer fixing bracket,
Wide M6 washers,
Hex nut M6,
Screw M10 x 20,
Hex nut M10
Double cone
Galvanised connector M10x1

To fix the reducer, proceed as follows.

- Mount the two studs  in the relative holes on the reducer body 
and fix them with an M3 Allen key.

- Insert the brass bushes  into the studs with the widest part lying on
the reducer body .

- Bend the steel bracket  to size and insert the shorter slot into the
two studs .

fig. 10

3

4
9

10

5

8
7

2

1

6
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- Position the wide M6 washers .

- Fix the bracket to the reducer using the M6 nuts .

- Before fixing the reducer-bracket assembly to the car, connect the gas
inlet tube from the lock-off valve using the double cone  and M10
connector .

Fit the reducer-bracket assembly to the bodywork of the car in the chosen position using the
M10x20 screw  and the M10 hex nut  (see figure 11).

Mount the reducer vertically (see paragraph 4.2) so that the pressure adjustment screw is easy to
reach and the LPG outlet connector, the MAP nozzle, the overpressure valve and the water pipes
are roughly directed towards the relative components. Take care to prevent it from touching mov-
ing or hot parts. Make pneumatic connections from the reducer to the injector assembly, from the
overpressure valve to the nozzle upline from the butterfly valve and from the upper cover of the

Bolt for fixing the
reducer to the car

body-work

Reducer / Vaporiser

Suitably shaped
bracket for fixing
the reducer to the

car body-work

Hoses for heating
the reducer /

vaporiser
fig. 11
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reducer to the MAP tap downline from the butterfly valve.
Connecting the reducer to the cooling circuit of the car

T-shaped water union
Hose clamp Ø 16 ÷ 27

Install the reducer heating circuit as shown below, taking care to reduce the loss of liquid coolant
to a minimum:
1. cut the two engine coolant hoses at the bulkhead between the engine compartment and the

interior, and insert the two T-shaped unions .
2. attach the hoses for heating the reducer to the other ends of the unions.
3. attach the hoses to the relative pipes on the reducer.
4. tighten the entire hydraulic circuit installed with the hose clamps D. 16 – 27 .
5. vent the cooling system.
Connecting the reducer to the injector assembly

Gas hose E67-R01 Ø 12x19
Gas Temperature / Pressure
Sensor
 Hose clamp Ø 12 ÷ 22
 LPG filter

Supply the LPG to the FAST injector assembly as shown below (fig.12):
1. install the LPG filter  and the gas temperature / pressure sensor  in series between the

reducer and the injector assembly,
2. cut the 12x19 E67-R01-approved hose  into three sections.
3. install and tighten the compressed air circuit using the six hose clamps D. 12 – 22 .

ATTENTION
MOUNT THE LPG FILTER HORIZONTALLY

2
1

3

4

1

2
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Connecting the reducer to the M.A.P. sensor and discharging overpressure

“Only air” hose
Y-shaped union
Hose clamp

Install the overpressure discharge circuit as follows (fig. 13):
1. fix a section of “only air” hose to the reducer overpressure valve hose connector using the

hose clamp.
2. cut the hose to length and attach it to the nozzle fixed to the air filter or downline from the

airflow meter, if fitted.
3. fix the hose with the hose clamp.

Install the inlet manifold pressure measurement circuit as follows (fig. 14):
1. mount a length of “only air” hosing to the manifold pressure delivery nozzle fitted downline

from the butterfly valve and secure it with a hose clamp,
2. cut the hose so that it can reach the immediate vicinities of the reducer and the FAST control

unit and then attach the free end to the Y union,
3. connect two lengths of “only air” hose and fix them with two hose clamps to the free ends of

fig. 13

Air filter

Overpressure
discharge

nozzle in air
filter

Reducer
overpressure

discharge hose
connector

Overpressure
discharge hosing

2

1

3

fig. 12

LPG inlet hose
from reducer

Injector
assembly

Temperature / Pressure sensor LPG filter
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the union. Taking care to keep them as short as possible, connect one to the M.A.P tap on
the FAST control unit and the other to the reducer pressure delivery nozzle.

4.8 Installing the Electronic control unit

Bracket for fixing the electronic control unit,
Electronic control unit,
M6 x 30 screw for fixing the bracket to the control unit,
M6 washer,
M6 nut,
4.8x16 self-tapping screws for fixing the control unit supports to the chassis or bodywork of
the car.

Cut two pieces from the fixing bracket  and shape them so as to be able to fix the control unit
 in the required position. Fix the two brackets to the control unit using the screws , washers
 and nuts . Fit the control unit to the bodywork of the car using the self-tapping screws .

Position the electronic control unit in the engine compartment. Make sure to respect the following
requirements:
- mount the control unit as far away as possible from the spark plug wires and the high-voltage

5

1

3

4

2

6

fig. 14

M.A.P. signal
delivery nozzle on

reducer

M.A.P. signal
delivery nozzle on
inlet manifold and

Y-union

M.A.P. signal
delivery nozzle on

control unit
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ignition circuit
- mount the control unit in an area where the temperature is not normally very high; do not

position it near the engine exhaust manifold
- do not fix it to the engine assembly
- even though the control unit is airtight, do not fix it in a position where it can be directly sprayed

by water
- to ensure the MAP tap connection is not too long, install the FAST control unit as near as

possible to the reducer and butterfly valve body.
Generally speaking, it should be positioned near the engine battery.

4.9 Installing the EMU FAST electronic control unit

EMU FAST control unit,
4.8x16 self-tapping screw for fixing the EMU FAST con-
trol unit to the chassis or bodywork of the car.

Position the control unit  in the chosen point and fix it with the self-tapping screw  supplied
with the kit.

Position the control unit in the engine compartment taking care to respect the following require-
ments:
- mount the control unit as far away as possible from the spark plug wires and the high-voltage

ignition circuit
- mount the control unit in an area where the temperature is not normally very high; do not

position it near the engine exhaust manifold
- do not fix it to the engine assembly
- do not fix it in a position where it can be directly sprayed by water

fig. 15

Electronic control
unit bracket

Electronic control
unit

1

2
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fig. 16

EMU FAST control
unit

Fixing screws for
the EMU FAST

control unit

Generally speaking, it should be positioned near the engine battery.
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5.0 Electrical connections
5.1 RPM signal
FAST is a phased Sequential Injection system and, as such, the revs input is used to synchronise
the whole system.
In order to optimise conversion, assess the capture method with care.
The selection criteria is the following:
- Always prefer the RPM signal from the petrol control unit; locate its position on the connec-

tor with the wiring diagram of the car or by directly visualising the signals with an oscillo-
scope

- In some recent models of car, the RPM counter signal is conveyed on the Can Bus and
contains no phase information.
In this case, choose the negative signal on the ignition coil.
When capturing this signal, remember that if the grounds of the ignition coil are not in good
condition, discharge may be incorrect and generate impulses on the low voltage side that
may disturb system operation: in these cases, if it is not possible to eliminate the cause, use
a rev amplifier to decouple the circuits.

Make the electrical connection to the rev counter signal or the ignition coil negative signal by
stripping the signal wire for a sufficient length to allow the BLACK wire from the FAST control unit
to be soft soldered; insulate the connection with insulating tape.
If the FAST control unit does not detect a correct RPM signal, the system will not allow the car to
shift from the petrol mode to the LPG mode. The red status LED will shine and the green status
LED will flash on the switch.

5.2 Lambda probe signal (before catalyser)
The Lambda probe signal is not required for the FAST signal but it may be useful when calibrating
the system. Check the Lambda probe works properly in the petrol mode before connecting it to the
FAST system. To prevent electromagnetic disturbance, do not lay the sheath with the WHITE wire
near the ignition coil.
The Lambda probe signal is captured by pinning the WHITE wire of the FAST cable harness to
the Lambda probe signal wire (the BLACK wire of the probe is generally the signal wire).

ATTENTION
THE COLOURS OF THE LAMBDA PROBE WIRES IN THE EXPLANATIONS AND THE ELEC-
TRICAL DIAGRAM REFER TO THE SECTION FROM THE PROBE TO THE CONNECTOR.
AS THE SIGNALS ARE ALWAYS CAPTURED AFTER THE PROBE CONNECTOR AND THE
COLOURS OF THE WIRES OFTEN CHANGE, MAKE SURE TI REFER TO THE CORRE-
SPONDING WIRE BEFORE THE CONNECTOR.

5.3 Connecting the reducer temperature sensor
The FAST system uses the reducer temperature signal for various purposes. The temperature of
the reducer is one of the variables that govern switching from the petrol mode to the LPG mode.
Switching from petrol to LPG is only allowed with the temperature of the reducer reaches the set
switching temperature. Connect the temperature sensor by attaching the GREY-BLACK wire of
the cable harness to one of the two sensor terminals on the reducer and earthing the other.
If the temperature sensor does not work correctly or is not connected, the system will not allow
you to switch from petrol to LPG. The red status LED will shine and the green status LED will flash
on the switch.
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5.4 Connecting the level indicator
The FAST system includes a digital fuel level indicator located in the MICRO switch. The wiring
harness of the FAST system is fitted with a level sensor connecting wire. Install the Lovato level
sensor by connecting the green wire of the level sensor mounted on the multivalve to the green
wire of the FAST cable harness and the purple wire of the sensor to the red wire of the FAST cable
harness (12 V key on).
Specific connections for other kinds of sensor are shown in the following table:

5.5 Connecting the LPG multivalve and lock-off valve
Connect the sheath with the BLUE and BROWN wires to the multivalve coil power wires. Connect
the BLUE wire to the RED wire from the multivalve, and the BROWN wire to the BLACK wire.
Connect the two-way male connector to the corresponding female connector located on the coil of
the LPG lock-off valve.

5.6 Connecting the injector power connector
Connect the male connector on the FAST wiring harness to the corresponding female connector
on the FAST injector assembly.

5.7 Connecting the power supply
When using the car, FAST system parameters are temporarily updated in a temporary memory on
the control unit and then saved to the to the memory of the control unit whenever the car is turned
off.
Connect the RED / BLACK wire to the positive battery terminal, interposing a 7.5A fuse, and the
BROWN wire to the negative battery terminal.
Connect the RED wire to the 12V key on circuit (not timed) interposing a 5 A fuse.

ATTENTION
ALL CONNECTIONS WITHOUT CONNECTORS MUST BE SOFT SOLDERED IN ORDER
TO PREVENT RUSTING AND FALSE CONTACTS.

FAST harness
PURPLE (Black) 

wire GREEN wire GREEN wire

Lovato 12V key on Harness GREEN wire Sensor GREEN wire
0 ÷ 90 Ω To earth Harness GREEN wire Sensor GREEN wire

0 ÷ 95 Ω To earth Harness GREEN wire Sensor GREEN wire

90 ÷ 0 Ω To earth Harness GREEN wire Sensor GREEN wire

AEB To earth Harness GREEN wire Sensor GREEN wire

Reserve To earth Harness GREEN wire Sensor GREEN wire
Without 
sensor - - - - - - - - - - Insulate

Sensor
Sensor
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6.0 Wiring diagram
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7.0 Pneumatic diagram

2

Tubo gomma 12 x 19 (Codice 135130)
12 x 19 rubber pipe (Part number 135130)

Filtro aria
Air filter

Dispositivo misurazione portata aria
Air mass metering device

Tubo gomma 4 x 10 (Codice 135031)
4 x 10 rubber pipe (Part number 135031)

Tubo gomma 5 x 10,5 (Codice 135035)
5 x 10,5 rubber pipe (Part number 135035)

Tubo gomma 15 x 23 (Codice 135036)
15 x 23 rubber pipe (Part number 135036)

Tubo rame 4 x 6 (Codice 434004)
4 x 6 copper pipe (Part number 434004)

Tubo rame 6 x 8
6 x 8 copper pipe

Attacco di carica
Fill in plug

Elettrovalvola GPL
LPG lock-off valve

Multivalvola
Multivalve

Collettore di aspirazione
Inlet manifold

Corpo farfallato
      Throttle body

Ingresso acqua
Cooling water in

Riduttore
Reducer

Uscita acqua
Cooling water out

SCHEMA PNEUMATICO IMPIANTO FAST

25 - 02 - 04
last revision date

F__ - ___
file name

revision 001
Pag.   1/1

1

3

Collegato sul fondo
Connected on the bottom

1

Gruppo elettroiniettori
Electro-injectors assembly

1

Per vetture con sistema a filo caldo

Per vetture con sistemi diversi dal filo caldo

Vista dall'alto
Top viewCentralina di controllo

Control Unit
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8.0 User information

The MICRO switch is the interface between the end user and the FAST system. This component
displays the operating status of the car, the gas level in the tank and allows various operations to
be performed, such as setting the gas or petrol modes, and, in case of emergency, starting the car
directly in the gas mode.

The operating LED’s display the power status of the car: the green LED at the top left refers to
gas, the red LED at the top right refers to petrol. The button with the Lovato logo is used to
manually switch from petrol to gas and vice-versa and to force engine ignition in the gas
mode. Lastly, there are five level indicator LED’s at the bottom.

Indicating the quantity of gas in the tank
The amount of fuel in the tank is measured by the relative indicator LED’s as shown below:
- 1 red LED on = reserve
- 1 green LED on = tank ¼ full
- 2 green LED’s on = tank ½ full
- 3 green LED’s on = tank ¾ full
- 4 green LED’s on = tank full
Operation

Initial switching to LPG
To switch from the petrol mode (RED LED on) press the button. The GREEN LED starts flashing

(gas enabled). In this condition, the car is still working in the petrol mode. When all the
conditions required for switching have been satisfied, the control unit switches from the
petrol mode to the LPG mode. The RED LED switches off, the GREEN LED switches on and
the buzzer confirms the shift from the petrol mode to the LPG mode with two short sounds.

Subsequent switching
- If the car was turned off in the petrol mode, when the dashboard is turned on the switch

shows the amount of gas in the tank, the gas LED is off and the petrol LED is on. When the
engine is turned on, the switch remains unchanged and the car works on petrol. To switch to
gas, press the switching button; the green gas mode LED flashes: the car still works on
petrol and the FAST system waits to be enabled by the FAST electronic control unit to switch
to gas. As soon as it receives the enable, switching takes place: the green gas mode LED
turns on and the petrol mode LED turns off. The buzzer sounds.

- If the car was turned off in the gas mode, when the dashboard is turned on the switch shows
the amount of gas in the tank, the gas LED is off as is the petrol LED. When the engine is
turned on, the green gas mode LED flashes: the car works on petrol and the FAST system
waits to be enabled by the FAST electronic control unit to switch to gas. As soon as it re-
ceives the enable, switching takes place: the green gas mode LED turns on and the petrol
mode LED turns off.

fig. 17

Indicatore di livello

Spie di funzionamento

Pulsante di commutazione
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The engine, therefore, is normally turned on in the petrol mode in order to keep the petrol injection
system efficient; the system automatically switches to the gas mode when the engine reaches the
set temperature.

Switching from LPG to petrol
Switch to the petrol mode, simply press the switching button: the green gas LED turns off and the
red petrol LED turns on.

Emergency operation
In case of emergency, the engine can be started in the gas mode as shown below:
- press the switching button with the engine off
- turn the key and release the button after 3 seconds
The switch will show the RED LED on and the GREEN LED flashing.
Now you can start the engine.

Automatic switching to petrol
The system automatically switches from the LPG mode to the petrol mode when the amount of
LPG inside the tank is no longer able to maintain the pressure required to power the car correctly.
When the car is switched to petrol due to the lack of LPG, the buzzer emits long, repeated sounds
which only stop after pressing the switching button. Switching to LPG will only be permitted again
after filling up the tank.

“Car safety” condition
The “car safety” condition occurs when the number of revs measured by the electronic gas control
unit falls under a set safety threshold. In this condition, all the gas delivery valves are closed and
the car reverts to the petrol mode. This feature is required by current legislation in order to keep
the system safe in case of an accident. The “car safety” condition can also occur, for example,
when the engine stalls or breaks down. The gas and petrol LED’s both flash and the level
LED’s turn off. To reset the system, simply restart the engine. In the event of a fault or an acci-
dent, contact an Authorised Lovato Fitter.
A table summarising the various signals given by the buzzer is shown below.

ATTENTION
DO NOT TRAVEL IN THE GAS MODE WITH THE PETROL TANK EMPTY: PREVENT THE
PETROL PUMP FROM RUNNING DRY BY KEEPING THE PETROL TANK AT LEAST A QUAR-
TER FULL.

ACTION BUZZER
Pressing the switching button 1 short sound
Switching to gas 2 short sounds
Entering on LPG reserve 1 long sound
Low reducer pressure detected (no fuel) Long repeated sounds
Starting in gas mode 2 long sounds
Problems with pressure and temperature sensors, or reducer is cold 3 long sounds
Entering or exiting the basic calibration mode Sequence of 6 short sounds
Problems with gas or petrol injectors Repeated sounds
Gas supply relay jammed ON Repeated sounds
Probelm with MAP sensor Repeated sounds
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9.0 FASTCOM calibration and diagnostics software
To install FASTCOM you must first obtain the FAST installation CD code 512???.

9.1 Programme installation guide.
To install FASTCOM, insert the installation CD and follow the instructions on the screen.
If the autoinstall procedure doesn’t run, install the programme as follows:
1) insert the CD in the drive,
2) click on START and then on SETTINGS and CONTROL PANEL; the following window opens

3) click on INSTALL APPLICATIONS,

4) click on INSTALL and then FORWARD,
5) make sure that d:\setup.exe appears on the command line and click on end. If d:\setup.exe

does not appear, click on browse and look for the file setup.exe manually.
6) follow the instructions on the screen.
7) after the installation procedure has finished, remove the CD from the drive and run the

programme.

9.2 Connection between PC and control unit

The PC and the control unit are linked with the Code 540011 serial connection. Connect the
RS232 serial connector on the interface harness to the relative socket on the computer. If you
have a last-generation computer without a serial port, fit a standard USB-to-serial port adaptor.
Connect the 4-pin female AMP connector on the interface harness to the corresponding 4-pin

fig. 18

fig. 19
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AMP male connector on the FAST harness. The following figure shows an example of a connec-
tion between the computer and the FAST system.

9.3 Start window

fig. 20

Serial interface
code 540011

Personal
computer

FAST wiring
harness

4-pin AMP male
connector on FAST

harness with protector

4-pin female AMP
connector on serial
interface harness

Connection between
serial interface and
FAST wiring harness

Connection between
serial interface and PC

Serial port on PC Serial interface RS232
connector

fig. 21
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The start window shows the version of Fastcom and contains a language selection option.

When the programme is run, the serial connection with the FAST control unit is checked and a
message is displayed both if the connection fails and if the connection is regular.

The compatibility between the versions of the serial connection and the SW on the control unit is
also checked. In the event of any discrepancies, an error message is displayed.

A communication symbol is located on the status bar to the left of the main window. A red cross
over the symbol means that communication is inactive.

9.4 Programming the FAST control unit
If your FAST control unit has a different programme from the one loaded in the computer, update
the software in the FAST control unit as shown below.
Select the BootLoader command from the Tools menu. The window shown in figure 24 appears.

The programme will show a “connection with control unit failed” message. Remove the fuses and

fig. 22

fig. 23

fig. 24



32

put them back again. After restoring power, reactivate the buttons on the “Coded BootLoader
Software for Control Unit” window that were deactivated (see figure 24). Click on Select File .cpt
to open the window shown in figure 25.

Select the coded control unit programming file (*.cpt) and click on Open. The window shown in
figure 26 appears.

Click on Enter. The programme begins to transfer the data from the computer to the FAST control
unit. Download progress is displayed on the status bar under the file selection window.
After downloading has finished, remove the fuses, put them back again and reset the control unit
from the file menu to implement the modifications.

ATTENTION
BEFORE UPDATING THE SOFTWARE OF THE FAST CONTROL UNIT, SAVE A COPY OF
THE RESIDENT DATA WITH THE FOLLOWING COMMANDS (SEE EXPLANATIONS OF
THE DATA AND FILE MENUS).

fig. 25

fig. 26
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9.5 Data management in the FASTCOM programme
Two types of data are contained in the mappings: permanent data, which is saved to a permanent
memory on both the computer (mapping file) and the FAST control unit (flash memory), and vola-
tile data, which is saved to RAM memory on both the computer and the FAST control unit. All the
mapping modifications made when calibrating the car are temporarily saved in the RAM memory
and are then transferred to the permanent memory when the file is saved on the computer and 30
seconds after disconnecting the 12 V key on power supply in the FAST control unit.

9.6 Explanation of the drop-down menus in the FASTCOM programme

File menu

The items in the “File” menu are used to:
1 load data (mappings) from a mass memory unit
2 save data (mappings) to a mass memory unit

fig. 27

Permanent
memory

Temporary
memory

fig. 28



34

4 reactivate periodic reading of sensors in the event of problems
5 reset the FAST control unit
6 force the interruption of serial communication (in order to work only locally)
7 open the integrated block notes for writing, saving, loading and printing notes
8 exit the programme.

View menu

The items in the “View” menu are used to:
1 Add graphics to the sensors window
2 Remove graphics from the sensors window

Data Menu

The items in the “Data” menu are used to:
1 download all screen data to the FAST control unit
2 load all the data from the FAST control unit (overwriting the data on the computer screen)
3 open the sensors and flags view window
4 open the map of the multipliers and petrol times
5 open the corrective factor vector window
6 open the operating setting parameters window
7 open a window of parameters to attach to the mappings when they are saved to file

fig. 29

fig. 30
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Tools menu

The items in the “Tools” menu are used to access:
1 BootLoader for programming the FAST control units if they require reprogramming
2 Data Logger for tracing and memorising the values transmitted by the sensors
3 diagnostics window
4 basic calibration procedure
5 optional advanced calibration procedure

Settings Menu

The “Settings” menu accesses the Fastcom parameters.

Window menu

fig. 31

fig. 32

fig. 33



36

The items in the “Window” menu allow the various open windows to be arranged on the screen in
various ways.

“?” menu

The items in the “?” menu are used to access:
1 Visualisation of the FAST system installation manual
2 Fastcom programme information

9.7 Sensor and status control

From the “View” menu, you can expand the sensors window to obtain a graphic display of system
values and statuses.
Values displayed:
Trail – gas temperature in Rail
Trid – temperature of reducer
Prail – gas pressure in Rail
MAP – pressure in intake duct
Q – gas flow parameter
RPM – engine RPM
Level – quantity of fuel in tank
Tbenz – petrol injector open time

fig. 34

fig. 35
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Lambda – lambda probe value
Molt – multiplier applied
Tgas – gas injector open time
Statuses displayed:
Sensors OK – LED on if sensor data is significant
Cut-off – LED on if in cut-off mode
Gas status – LED on if in gas mode
Safety-car – LED ON if in safety-car mode (gas injectors closed if car stalls)
The “Switch” button changes the display to gas or petrol.
The indicative values of a car at minimum heat regime are shown below.
Trail – 30° C
Trid – 75 ÷ 90° C
Prail – 110 ÷ 120 kPa ( ± 85 + M.A.P. value at minimum)
MAP – 30 ÷ 40 kPa
Q – ~ 3 %
RPM – 600 ÷800
Level – Depends on the quantity of LPG in the tank
Tbenz – 4 ÷ 5 ms
Lambda – 0.2 ÷ 0.9 V oscillating (for 0÷1V probe)
Molt – 15000 ÷ 18000
Tgas – 4.5 ÷ 5.5 ms

9.8 Parameters

After clicking on “Parameters” you are asked whether to load the data from the control unit or view
those already present in the memory of the PC.
The system operating parameters are displayed.

Some parameters can be modified to change the way the system works

To access the parameters managed in the “Tbenz min” and “Offset Tar” items, click twice on the
word “values” in the top left-hand corner.
Values displayed:
- Inj assembly A-H: indicates the injector assembly the single injectors belong to. The same

fig. 36
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number on more than one injector indicates that these injectors belong to the same assem-
bly. For example, injectors A,B,C,D marked 1,2,3,4 describe a phased 4-cylinder injection
system, 1,1,1,1 instead describes 4-cylinder full-group injection as all the injectors belong to
assembly 1.

Values displayed (modifiable):
- RPM threshold: this is the threshold over which switching may take place if the other condi-

tions (temperature of reducer, change delay, RPM<4,000 and MAP pressure<60KPa) are
satisfied.

- Change delay: this is the minimum delay (in sec.) between starting the engine and switch-
ing.

- Trid threshold: this is the temperature threshold for switching.
- Change type: this is the window for selecting the type of switching.
- Sensor type: this is the window for selecting the type of Sensor for indicating residue gas.
- RPM factor: this is the window for selecting the type of RPM input.
- Injector type: chooses between Lovato and Matrix injector piloting
- Compar. threshold: sets the parameter for reading the RPM input stage depending on whether

the input signal is low (0-5V or 0-12V), high (6-12V) or average. The set thresholds are:
either low = 2.5V
or average = 6.0V
or high= 8.0V

9.9 Calibration
Do not open other windows in the programme during the calibration procedure. The sensors
window can be used.
After running the calibration procedure with the relative button, various boxes showing calibration
progress are automatically displayed in sequence.

When the “Forward>>” button shines green, you can move on to the next step. In any case, you
are automatically moved on to the next step after a few seconds.

fig. 37
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During calibration, the number of petrol injectors connected is established (LED ON) and the type
of grouping is checked (full-group, semi full-group or sequential injection).

Adjust the RPM factor to synchronise RPM visualisation with the RPM counter of the car. Press
“Forward” to continue.

fig. 38

fig. 39

fig. 40



40

The petrol injection time is acquired as it is used to calculate the multipliers after switching the car
to the gas mode:

ATTENTION
WHEN SWITCHING TO GAS DURING THIS PHASE, THE CAR MAY STOP. IN THIS CASE A
WINDOW WILL BE DISPLAYED TO ALLOW THE PROCEDURE TO CONTINUE.

fig. 41

fig. 42

fig. 43
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After identifying a more or less correct work point, the procedure continues with a detailed
control.

After this detailed control, the multipliers map is updated and the car is switched to the petrol
mode.

During this initial calibration phase, if the gas pressure is too high or too low, a warning window
will be displayed at the end. Adjust the pressure within the range (85+ map pressure at minimum)
and recalibrate.

fig. 44

fig. 45

fig. 46
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After calibration, the maps and parameters are saved to the RAM memory on the control unit. The
data may be deleted if the battery positive is disconnected.
To memorise it permanently, simply switch off the panel and wait about 30 secs. until the window
signalling that the permanent memory (EEPROM) is being updated appears. This permanent
memorisation procedure is also valid for modifications made manually by modifying other inter-
face data.

ATTENTION
ALWAYS WAIT 30 SECONDS AFTER TURNING OFF THE CAR BEFORE DISCONNECTING
THE POSITIVE BATTERY. AS WELL AS LOSING ALL THE DATA MODIFIED AFTER THE
LAST TIME THE CAR WAS TURNED OFF, ALL THE MEMORISED DATA MAY ALSO BE
LOST. IN THIS CASE, THE CONTROL UNIT WILL START WITH FACTORY-SET DATA.

9.9.1Advanced calibration

This procedure can improve, if required, the mapping obtained from the auto-calibration process
Press Start to begin the Advanced Calibration procedure and terminate it with the Stop button.
During calibration, each cell displays the average Petrol Time acquired during an 8 second inter-

fig. 47

fig. 48
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val in which the position of the cursor remains in the centre of the 9X9 grid (red symbol). The Gas
Time (green symbol) is also shown if the car is running on gas, as well as the average calculated
Multiplier (indicated with the symbol “!”).
If you exit the cell centre during acquisition (padlock active), the samples memorised up to that
point are maintained. Acquisition is automatically started for each operating status (Gas/petrol)
when the cell centre is maintained for over 2 seconds.
If the reducer temperature is too low, the whole window is disabled.
The “Switch” button changes to gas or petrol. The current status is shown by the symbol above
the button.
In the “Modify” box, you may block the update status and edit the previously calculated Theoreti-
cal Multiplier.
The “Reset” button resets all the boxes in the Map.
With the car in the petrol mode, the “Acquire” button forces the acquisition of the Petrol Time while
in the gas mode it forces the acquisition of the current time and calculated multiplier.
After terminating Advanced Calibration by completely acquiring (Gas and Petrol mode) a suffi-
cient number of cells, press the “Calculate Map” button to find the Theoretical Multipliers of each
cell and interpolate the results on the main 8X10 Multipliers Map.
Press Apply ECU to transfer the 8X10 Map to the control unit.

9.10 Diagnostics

After clicking on “Diagnostics” you are asked whether to load the data from the control unit or view
those already present in the memory of the PC.
The counters relative to internal system diagnostics are displayed.
Values displayed:
- Gen - = 1 if a fault is found.
- Timer - gas and petrol operating time counters (in hours).
- DP - signals when reducer pressure is too low (and for too long) com-

pared with the pressure measured during calibration. This hap-
pens when the gas runs out and the car is automatically switched
to petrol.

- Pmap - this is the MAP sensor fault counter.

fig. 49
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- Trail - gas temperature sensor fault counter.
- Trid - reducer temperature sensor fault counter.
- Prail - gas pressure sensor fault counter.
- Gas injector problems - series of fault counters on each gas injector.
- Petrol injector problems - series of fault counters on each petrol injector.
- Control unit software - shows the version of the software installed in the FAST electronic

control unit.
Press “Reset Diagnostics” to reset the counters (apart from the Timers).

9.10.1 “Diagnostics flag” window

The red LED’s signal faults on injectors and sensors in real time. LED ON means that a fault is
present.
Use the selection boxes in the “Enable controls” section to enable or disable individual controls.
When the car is stopped, the faults are reset but the relative counters are memorised (cf. Diag-
nostics on previous page). The LED’s can also be commanded with the “Reset flags” button.
It is also possible to set the threshold under which the reducer cold diagnostic trips with conse-
quent switching to petrol.

9.11 Logger

fig. 50

fig. 51
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The Data Logger window shows the progress of the parameters selected in the bottom left-hand
box.
It is possible to save the graph to a file, choosing whether to reset the file before writing the data
(“Overwrite”) or add the data to that already existing in the file (“Add”).
The “View points” shows the exact points sampled in the graph (the continuous trace is con-
structed by interpolation between these points).
The “View Log File” button shows the associated values in tabular format at the moment they are
sampled (text file).

9.12 Maps

After clicking on “Maps” you are asked whether to load the data from the control unit or view those
already present in the memory of the PC. The map is established during auto-calibration.

9.12.1 Map management: “Multipliers” directory

The values of the MAP/RPM multipliers are displayed. These parameters are used by the control
unit to calculate Tgas.
The RPM/MAP work area of the car is displayed by the red cell inside the map. For a precise
indication of the position inside the red cell refer to the fine position box: the cell is divided into
nine boxes in which a mobile yellow cursor indicates the area of the cell on the map currently
identified by MAP and RPM. When the yellow cursor is positioned in the central box of the nine-
element matrix, it means that the values of MAP and RPM correspond to the centre of the cell
illuminated in red on the map.
To modify a cell or group of cells
1 block the cursor by clicking on “start/stop cursor”
2 select the cell or group of cells (by dragging the mouse)
3 enter the new value and press “new value”
To work on an individual cell, you can also use the suggested value and attempt to reach the
displayed Tbenz target value. To activate the hints mechanism the “Suggestions” box must

fig. 52

fig. 53
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beselected. For the suggestion to work correctly, the Petrol Times map must already be present.
The most important sensors are also displayed in this window.
The “Calibration constant” shows the value obtained during the calibration phase to which the
map refers. Change its value by setting a variation percentage and pressing “Enter”. All map
values are modified by the set percentage.

9.12.2 Map management: “Petrol times” directory

Access the “Petrol times” directory from the maps management window
To modify a cell or group of cells
1 block the cursor by clicking on “start/stop cursor”
2 select the cell or group of cells (by dragging the mouse)
3 enter the new value and press “new value”
Use the enter command to work on an individual cell during operation and capture the displayed
petrol time.

9.13 Vectors

After clicking on “Vectors” you are asked whether to load the data from the control unit or view
those already present in the memory of the PC.
Ranges RPM and MAP are displayed.
The RPM and MAP vectors establish the reference points of the multipliers map. These values
are also shown in the first row and the first column of the maps window respectively. To modify one
or more cells:
1 Select the cell or group of cells (by dragging the mouse)
2 enter the new value and press “new value”

fig. 54

fig. 55
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Annex 1

MAINTENANCE OF INJECTORS XJ5XX
The injectors rail is a high precision device that in normal operating conditions needs
no maintenance. Particular conditions of use ( non complying fuel, exhaust or non
fitted filter) may require the disassembly and cleaning of the rail, to be done with care
by skilled technicians. It is particularly recommended to ensure the most careful
cleaning of the workbench. Foreign matters, even of small dimensions, accidentally
introduced inside the rail can generate functional defects.

The use of solvents or chemical products to clean the internal or external parts of the
rail is expressly vorbidden.

Tools: setscrew wrench 2,5 – setscrew wrench 5 – Allen wrench 13 – small
dimensioned tweezers or screwdriver.
Cleaning material: blotting paper or equivalent, little brush.
Equipment: pneumatic system

Remove the front flange acting on the
4 screws by the setscrew wrench 2,5

Clean this part particularly on the inlet
side and control that the seals aren’t
occluded.

Remove the 4 sealing o-rings placed on
the flaps support by means of the
tweezers

Remove the two locking screws of the
flaps support by means of the setscrew
wrench 2,5  keeping the support in
position on the rail.
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Overturn the rail keeping the flaps
support in position and lay it on the
workbench avoiding the internal
components to come out (Pict. 3-
4).

Remove the rail as well as the
sealing lid by means of the Allen
wrench 5 or the eventual pressure
tube by means of setscrew wrench
13.

Clean with compressed air  the
inside of rail and pipelines,
removing eventual oil deposits or
foreign matters.
Carefully clean the contact
surfaces with absorbent, not
abrasive material, then with
compressed air.
Clean and carefully tighten the
sealing cap or the eventual
pressure inlet.
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Delicately remove the magnetic gap
from the flap support by means of
tweezers or little screwdriver, avoiding
to bend or deform the component.

Clean the surfaces by means of
absorbent material.

The highest attention is recommended
to avoid the bending or deformation of
magnetic gap.

Take off the flaps by means of
tweezers or  little screwdriver and
place them on the workbench
according to the original sequence
(Pict. 10-11).
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Clean the flaps by means of
absorbent material.
Verify that on the rubber surfaces
no foreing matters are present.

Take off the external seal, the linear
o-ring and metal lamina underneath
by means of tweezers or little
screwdriver.

Carefully clean the flaps support by
small brush and compressed air.
Check if outlet nozzles aren’t
obstructed.

Avoid any contact between metallic
parts and nozzles.

Put back carefully and in order the
external seal, the lamina and the
linea o-ring.

Put back the flaps according to
original sequence with the racking
area turned up.

Be sure that all the flaps have been
correctly placed into corresponding
seats.
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Put back in position the magnetic gap
on the two referring stakes located on
the flaps support, avoiding to bend or
deform the component.

Lean the rail on the flaps support
making reference to the lateral stakes.

Keep in close contact the rail with the flaps
support and overturn at 180°.

Tighten the flaps support on the rail with the
two short screws without forcing (The two
screws haven’t a rigid seal function).
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Be sure that the surfaces of the rail and
the flaps support are perfectly in
contact.

On the contrary, the flaps or the seal
aren’t correctly positioned.

Put back in position the seal o-ring on
the flaps support and check that in the
referring seats there are no foreing
matters.

Put back the front flange ensuring that
the seals position corresponds axially
to the nozzles on the flaps support.

Fasten the complete rail with the 4
screws giving a tightening torque of 12
Kg cm.

Note:
before setting up the the rail and failing
of adequate equipment, connect the
seal of compressed air inlet at 4-6 bar
and carefully verify that no leaks can
be  perceptable both from the body of
rail and the outlet seals.
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Annex 2

Routine maintenance

Similarly to any other vehicle parts, maintenance of Lovato equipment is vital for guaranteeing
system efficiency and safety. Use of the maintenance vouchers extends the lifetime of all the
equipment, thereby helping to reduce operating costs.

Inspection vouchers

Inspections are programmed every 15,000 km and allow the system to be kept in perfect working
order. These vouchers do not replace the maintenance vouchers issued by car makers, of course,
which must be performed at the established intervals. In this regard, the gas delivery system
should be controlled immediately after the maintenance operations required by the car makers in
order to prevent the repetition of certain operations.
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